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第一章 界面介绍 

 

1.1 子窗口切换键： 

当在图谱窗口内打开多个窗口,或其它功能窗口(如 temperature monitor 功
能)，每个子窗口会以一个有颜色的小方块表示，按下小方块即可切换子窗口。 

1.2 工具栏： 

 

  建立一个新的实验数据集 

  打开已经存在的实验数据集，其中又分三种格式： 
1. Open NMR data stored in standard Bruker format：打开标准 Bruker 

档 
2. Open NMR data stored in special formats：打开其它格式数据 
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1.2 工具栏： 

3. Open other file：打开其它类型数据 

  保存目前的实验数据集 

  将目前的实验数据集以 e-mail 寄出 

  打印实验数据集 

  复制当前的实验数据集路径 

  贴上复制下来的实验数据集路径 

  回到最近的 2D 图谱 

  回到最近的 3D 图谱 

 

  进入相位校正调整模式 

  进入化学位移校正模式(重新定义 ppm 位置) 

  进入基线校正模式 

  进入信号标定模式(peak picking) 

  进入积分模式 

  进入图谱重叠模式 

  进入距离量测模式 

 

  切换 Hz/ppm 单位 

  切换 Y 轴显示的相对高度或绝对高度 

  显示图谱总览(于图谱上方出现一个小画面) 

  于图谱上显示网格线 

 

  图谱强度比例乘 2 
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第一章 界面介绍 

  图谱强度比例除 2 

  图谱强度比例乘 8 

  图谱强度比例除 8 

  按住鼠标左键，上下拖动调整图谱强度比例 

  将图谱强度重设至窗口最合适大小 

 

  将图谱宽度重设至窗口最合适大小 

  显示全图谱 

  放大图谱宽度 

  按住鼠标左键，上下拖动调整图谱宽度比例 

  缩小图谱宽度 

  出现对话框，自行填入显示左右边界 

  回到上一次图谱宽度范围 

  锁定目前显示范围，在打开其它图谱时，会显示锁定时的

范围，按钮呈绿色即锁定，再按一次即解除。 

 

  图谱显示向右移动 

  按住鼠标左键，左右拖动移动图谱显示范围。 

  图谱显示向左移动 

  移至图谱最左侧 

  移至图谱最右侧 

 

  移至图谱最上方 

  按住鼠标左键，上下拖动移动图谱显示范围。 
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1.5 数据浏览器： 

  移至图谱最下方 

1.3 命令行： 

命令输入栏，使用键盘的↑、↓按键可来回搜寻输入过的命令。或从主菜

单→View→Command Line History 查看所有执行过的命令。 
输入 cmdindex 时，可察看所有命令并可点击查看说明。或直接以”help+

命令名”查看说明。如“help ft”会出现 ft 命令说明。 

1.4 状态栏： 

 显示命令执行状况。 

1.5 数据浏览器： 

共分 Browser, PFolio, Alias 三项，如下图示： 

 
1. Browser：以树状结构图表示目录层次，在含实验资料的目录上，以左

键拖动到右侧图谱区即可打开，或按右键有其它选项。 
2. PFolio：近期内打开过的图谱，以实验名称，编号等信息显示出来方便

点选。 
3. Alias：为图谱取一个别名，以便更快速索引。打开图谱窗口后，于 

Alias 页面按右键，选择 Define Alias for data in selected window，输入一个

别名(必须以英文字母开头)即完成别名建立。 
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第一章 界面介绍 

◎如何打开/关闭数据浏览器? 

从主菜单→View→Browser panel On/Off 来切换。 

◎如何在数据浏览器显示 Exp No.、Title？ 

在  Browser 页面中，于目录名称上按右键，选择  Expand & Show 
pulseprog/title 

◎如何在 Browser 页面中新增资料夹? 

在已存在的资料夹上按右键，点选 Add New Data Dir。TopSpin 的目录资

料结构  为<dir>/data/<user>/nmr/<name>/expno/pdata/<procno>，输入<dir>
的路径即可。 

◎如何将图谱复制回自己的计算机？ 

将图谱打开后，于命令行输入 expl 会打开一个数据总管窗口，并且路径为 
<dir>/data/<user>/nmr/<name>/expno/pdata/<procno> ， <dir> / data / 

<user> / nmr / 
<name>里面的数据即是使用者每个实验编号等资料，复制出来即可。 
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第二章 实验设置向导 

以下介绍在 TopSpin 中，实验设置的操作界面。关于详细的实验设置参

数，请参阅 Help → Acquisition reference manual. 
点选主菜单→ Spectrometer→ DataAcquisitonGuide 打开实验设置向导，

如下图： 

 
1. New Experiment： 建立一个新的实验数据集。 
2. Frequency Routing： 确认与选择实验核种。 
3. Lock：   选择样品所加入的 D-solvent 进行锁定。 
4. Temperature：  设置实验所需温度。 
5. Probe Match/Tune： 调整  Match/Tune 以达到信号最佳共振点

1。 
6. Sample Rotation： 依需求决定样品是否需要旋转及转速设置。 
7. Shim：   进行磁场匀场动作。若机器没有自动匀场功

能，则需要手动进行磁场 匀场调整。 
8. Acquisition Pars： 点击后进入实验参数页面，确认图谱范围2。 
9. Prosol Pars：  点击后自动执行”getprosol”，取得脉冲参数

值。 
10. Receiver Gain： 可手动输入 RG 值或选择自动计算。 
11. Go：   开始实验。 

                                            
1
调整Match/Tune的动作，若探头本身没有自动化功能，则需仪器负责人同意才能操作，以免伤害探头。 

2
在此页面下，要确认的有图谱的中心点(O1P、O2P)，图谱宽度(SW)，扫瞄次数(NS)，依使用者样本特

性而有所调整。其余参数不需改动，参数详细说明请参阅acquisition reference manual。 
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1.5 数据浏览器： 

12. To processing：  切换进入图谱处理功能(请参阅第三章)。 
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第三章 图谱处理 

3.1 手动处理图谱 

图谱处理的参数记载在 Processing Parameter 表格中3。 将图谱转换的

命令输入于命令行中，即会套用参数进行处理，命令列举如下： 
apk：  automatic phase correction (自动相位校正) 
fp：  Fourier transform +phase correction (傅立叶转换+相位校

正) 
abs：  automatic baseline correction (自动基线校正) 
efp：  Exponential multiplication +fp (套用 EM 窗口函数+fp ) 

3.2 半自动处理图谱 

主菜单→processing → Data Processing Guide 会出现图谱处理向导，如

图： 

 
若选取右上角 AutomaticMode，则所有步骤中的参数都自动设置，按照流

                                            
3
此页面的参数已设置好，通常不需要改动。关于详细参数说明，请参阅 processing reference manual。 
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3.2 半自动处理图谱 

程图依序点选即可完成。此方法并不建议使用于 2D 图谱上，因在“window 
function”选项中，只会自动采用 sin 和 SSB = 0，且仍需手动调整相位。 

若不选取右上角的 AutomaticMode，则每点选一个步骤，即会出现此步骤的参 
数调整窗口。 

1. Open dataset  打开一个数据集 
2. Window function  选择窗口函数4高级处理 FID 
3. Fourier Transform 进行傅立叶转换 
4. Phase correction  相位校正(参照第五章) 
5. Axis Calibration  化学位移校正(参照第五章) 
6. Baseline Corr.  基线校正(参照第五章) 
7. Advanced   高级选项，可进行图谱相加/相减/重叠峰拆解

等(参照第八章) 
8. Peak picking  标定 Peak(参照第五章) 
9. Integration Peak  积分(参照第五章) 
10. Plot / Print  图档排版/打印(参照第七章) 
11. E-mail / Archive  将图谱制成压缩档/以 e-mail 寄出 
 

                                            
4
窗口函数是一种数学函数，用以和最原始收集到的 Fid 信息做相乘处理，使得转换出来的图谱更能符合

期望。对于 1D 图谱常用的窗口函数有 EM、GM，对于 2D、3D 则常用 Sine、QSine。一般建议值如

下： 
1D 氢谱实验 EM LB = 0.3 
1D 碳谱实验 EM LB = 3 
2D 同核实验 F1:sine F2:sine F1: SSB = 2, F2: SSB = 2 
2D 异核实验 F1:qsine F2:sine F1: SSB = 2, F2: SSB = 2 
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第四章 图谱界面 

4.1 1D 图谱界面 

1D 图谱，可以分成以下区块： 

 

4.1.1 资料区： 

显示图谱 
在图谱显示区上按右键，会有如下选项： 

 
选择 Display Properties 会出现如下窗口，用以选择图谱上要显示信息种

类 
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4.1 1D 图谱界面 

 

4.1.2 标题区： 

显示实验名称、路径等。 

4.1.3 标签区： 

切换各种功能页面。 
其中标签区分为： 
1. Spectrum： 图谱显示，图谱显示的调整请参阅第一章工具栏介绍。 
2. ProcPars： 设置图谱处理参数 此页面的参数已设置好，通常不需要更

动。(关于详细参数说明请参阅 processing reference manual) 
3.工具栏按钮： 

  恢复上一次的更动 

  查看上次图谱处理的参数状态 

  改变图谱处理实验维度 

  输入关键词搜寻参数 
4. AcquPars： 设置实验参数 见注二，工具栏按钮说明如下： 

  恢复上一次的更动 

  进入”ased”模式，调整实验参数 

  查看上次做此实验的参数状态 

  执行”getprosol”，以取得脉冲校正值 

  该变实验维度，可在 1D、2D、3D 之间做切换。 
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第四章 图谱界面 

  输入关键词搜寻参数 
5. Title：  实验标题命名 

  将新写入的标题保存 

  将新写入的标题另存新档 

  取消正在校正的编写区，恢复到保存值 
6. PulseProg： 显示脉冲程序内文及显示实验设置的参数与提示等。 
7. Peaks：   Peak 列表，若有执行 Peak 标定的动作，则从此

页面可以看到 Peak 标定信息。 
8. Integrals：  积分列表 若有执行积分的动作，则从此页面可以看

到积分列表。 
9. Sample：  样品备注 此页面可以输入样品的相关信息，方便以

后查询。 
10. Structure： 分 子 结 构 ， 若 在 实 验 目 录 中 含 有 结 构 资 料 文 件

(xyz, .mol, .pdb, .cml, .out, .res)则会显示出分子结构。 
11. Fid：  Fid 画面，显示图谱原始 FID 图形。 

4.2 2D 图谱界面 

2D 图谱界面的操作模式，类似 1D 操作，并多了以下功能按钮： 

  切换是否显示 2D 图谱中，两个维度的投影 1D 图 

  将图谱以等高线圈模式显示 

  将图谱以渐层色表示 

  将图谱以立体图画出，如下图 

 

  锁定目前图谱等高线圈参数值 

  按住左键拖动，以改变等高线倍率值 
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4.3 3D 图谱界面 

  设置等高线参数，当图谱以等高线圈表示时，由此来设置

圈数及每圈的倍率值。 

4.3 3D 图谱界面 

3D 图谱类似 1D / 2D 操作，但多了以下功能按钮： 

  将抽取出的 2D 平面以等高线圈模式显示 

  将抽取出的 2D 平面以渐层色表示 

  将抽取出的 2D 平面以立体图画出 

  切 F3，显示 F1、F2 平面 

  切 F1，显示 F2、F3 平面 

  切 F2，显示 F1、F3 平面 

  切换到下一个平面(平面数等于图谱处理参数中各轴 SI 值) 

  切换到上一个平面(平面数等于图谱处理参数中各轴 SI 值) 

  按住鼠标左键，上下拖动以浏览各平面 

  出现窗口，输入想要观察的平面数值 

  将 3D 方块沿着 X 轴旋转 

  将 3D 方块沿着 Y 轴旋转 

  将 3D 方块沿着 Z 轴旋转 

  将 3D 图谱以立体图显示总览，如下图 
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第五章 1D 图谱处理 

图谱的处理上，可由图谱处理工具栏选择需要的功能。 

 

5.1 相位校正模式 

点选上图最左边按钮  

 
进入相位校正模式后窗口如上，其中： 
0： 以左键拖动，调整相位零阶校正参数。 
1： 以左键拖动，调整相位一阶校正参数。 
R： Reset，恢复到未调整前的值。 
90： 将相位正向转 90 度 
-90： 将相位反向转 90 度 
180： 将相位旋转 180 度 

  增加鼠标灵敏度，使拖动速度增加 

  减少鼠标灵敏度，使拖动速度减少 

  重设鼠标灵敏度 

  将相位值存入 2D dataset 

  将相位值存入 1D dataset，并离开 

  不保存离开 
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5.2 积分模式 

5.2 积分模式 

按下工具栏中 按钮则会出现以下画面。 

 

  以鼠标拖动想要积分范围 

  出现对话框，输入想要积分的范围值 

  分割积分区间 

  恢复上一次的动作 

  打开已存在的积分纪录档 

  保存目前所定义的范围区间，会出现以下窗口： 

 
Save Regions To ‘intrng’ 
将积分范围及值写入积分文件档 
Save Regions To ‘reg’ 将积分起来的图谱范围存入范围文件档，以供 

select 实验 或其它之用 
Export Regions To Relaxation Module 
将积分区间输出至 Relaxation Analysis 使用(T1/T2 实验) 
Save & show List 
保存积分值，并显示积分列表 

  微调积分曲线参数之一(bias) 

  微调积分曲线参数之二(slope) 

  定义积分范围最小宽度，若设为 1ppm 则以鼠标拖动范围 
时，须大于 1ppm 积分范围才成立，一般都设为零，即不限定 
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第五章 1D 图谱处理 

  增加鼠标拖动灵敏度 

  减少鼠标拖动灵敏度 

  重设鼠标拖动灵敏度 

  删除所选取的积分区间 

  选取所有的积分区间 

  将积分曲线乘 2 显示 

  将积分曲线除 2 显示 

  上下拖动鼠标调整积分曲线大小 

  按此钮出现小窗口，自行输入积分曲线倍率值 

  所有的积分曲线显示成等高度 

  保存积分值并离开 

  不保存离开 

5.3 图谱重叠模式 

按下工具栏 按钮，则出现如以下窗口： 
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5.4 化学位移校正 

◎如何将多份图谱重叠比较？ 

1.在“data browser”中，将”数据”以鼠标左键拖动进入图谱区 
2.在命令行以”re”命令进行呼叫，如键入 re 3 1 即是呼叫 Expno = 3, 

Procno = 1 的图谱进行重叠 

◎如何在重叠模式下选择单个图谱？ 

1.若在分隔显示模式中(如上图)可点击每个图谱右侧小方框即选取 
2.若在重叠显示模式下，因所有图谱重叠在一起，所以不会有小方框提

示，于是需要点击主窗口最左  (左图红色方框处)，打开各图谱信息，里面

显示颜 色方框与图谱对照，可直接点击选取。 

  取消选取 

  重设所有图谱的大小及位移 

  将所选取的图谱移除 

  切换”重叠/分隔”显示 

  切换是否显示各别图谱的文件名、放大率等信息 

  将选取图谱以拖动鼠标方式进行缩放，若没有单独图谱被 
选取，则所有图谱同时缩放 

  将选取图谱左右移动 

  显示所有单个图谱的相减结果 

  显示所有单个图谱的相加结果 

  将相加/相减的结果存入一个 Proc No.中 

5.4 化学位移校正 

点击工具栏 图标。 
于图谱区上，将光标移到参考信号上，点击左键即会出现一个小窗口，填

入想要 定义的化学位移值，如图： 
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第五章 1D 图谱处理 

 

5.5 基线调整 

点击工具栏 图标。 
基线校正，于一般  1D 图谱，只需在命令行键入  abs (auto baseline 

correction)，即可获得良好的校正结果。2D 图谱则打入 abs2，abs1 表示把两

个轴皆进行基线校正。 
点击后出现如下窗口： 

 

  切换“全图谱/最近一次范围值”为基线调整的宽度 

  采用多项式函数进行调整，右侧红框内会显示函数公式 

  采用 Sine 函数进行调整，右侧红框内会显示函数公式 

  采用指数函数进行调整，右侧红框内会显示函数公式 

 调整公式内的每个参数值 

  重设所有参数值 

  预览调整后的图谱结果 

  自行定义其线值的点(至少五个)，再由程序计算基线校正 

  保存离开 

  不保存离开 
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5.6 Peak picking/标定 Peak 

5.6 Peak picking/标定 Peak 

点击工具栏 图标，进入 peak picking 模式如下图： 

 

  点选此模式，可在图谱区上拉出方框，方框内若含有 
Peak 峰顶，则此 peak 将被标记。方框的左右即代表想要标记的图谱宽度；

方框的高低即代表上下限(peak 峰顶低于方框下边缘的不取，Peak 峰顶高于方

框上边缘也不取)，可同时画出许多方框。 

  调整方框的大小 

  删除所有方框 

  手动标定 peak。点选此模式，则鼠标移到想要标记的位

置， 按鼠标左键标记 

  半自动标定 Peak。此模式会从按下左键的位置向右寻找 
peak 峰顶，则不需精确对准峰顶。 

  删除所有 Peak 标记 

  将 Peak 标记存入 Peak List，离开 Peak picking 模式 

  不保存离开 
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第六章 2D 图谱处理 

2D 图谱处理与 1D 类似，但需顾虑到两个维度都要处理。 

6.1. 相位调整模式 

2D 图谱的相位调整模式如下图示： 

 
此时先在”右上角/左下角”各选一个 peak，在其上按右键→Add，以这些

Peak 做为相位调整的参考点，动作完成如下图： 

 

  切换进入等高线显示 

  进入横轴(Row)相位调整 

  进入纵轴(column)相位调整 

  将相位值存入 3D 数据集 

  不保存离开 
当进入”横/纵轴相位调整模式”时，即类似 1D 的相位调整模式，按钮功能
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6.3 2D 图谱重叠显示 

亦相同： 

 
将 Row, Column 两个维度单个进行相位调整完成后，即完成 2D 相位调

整。 

6.2 2D 化学位移校正 

点 进入化学位移校正模式，并在参考信号上面按左键，出现以下窗口 

 
再分别填入两个轴的校正值。 

6.3 2D 图谱重叠显示 

于工具栏上按下 按钮，进入以下画面： 
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第六章 2D 图谱处理 

◎如何将多份 2D 图谱重叠比较？ 

1.在”data browser”中，将”数据”以鼠标左键拖动进入图谱区； 
2.在命令行以”re”命令进行呼叫，如键入 re 3 1 即是呼叫 Expno = 3, 

Procno = 1 的图谱进行重叠。 

◎如何在重叠模式下选择单个图谱？ 

1.若在分隔显示模式中(如上图)可点击每个图谱右侧小方框选取 
2.若在重叠显示模式下，因所有图谱重叠在一起，所以不会有小方框提

示，于是需要点击主窗口最左侧 (左图红色方框处)，打开各图谱信息，里面

显示颜色方框与图谱对照，可直接点击选取。 
也可做 1D – 2D 的重叠，如下图： 

 

  取消对单个图谱的选取，此时进行移动，缩放等动作将对

所有重叠的图谱一起动作 

  重设对单个图谱所做的”大小/移动”之更动 

  将选取的图谱移出重叠模式 

  将所有图谱的等高线参数设成跟第一张图谱一样 

  切换等高线圈显示与否 

  对选取图谱做强度调整 

 对选取图谱进行上下左右移动 

  点选此模式，鼠标在图谱上移动会显示光标处横轴(Row)
的 1D 图像，转动鼠标中键(即滚轮)可调整 1D 图像大小， 此时按右键可从选

单选”Grab Row / Column”获得此时的 1D 图像，或按右键从选单选”Extract 
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6.4 2D Peak picking 

Row / Column”将 1D 图像另存一个 Proc no. 

  点选此模式，鼠标在图谱上移动会显示光标处纵轴 
(Column)的 1D 图像，转动鼠标中键(即滚轮)可调整 1D 图像大小，此时

按右键可从选单选”Grab Row / Column”获 得此时的 1D 图像，或按右键从选

单选”Extract Row / Column”将 1D 图像另存一个 Proc no. 

  进入计算投影模式，可将 Row / Column 维度的投影量存 
成一个 Proc no. 

 当执行”Grab Row / Column”获得 1D 时，以此钮来调整

所 显示的层数往”上/下”移动 

6.4 2D Peak picking 

手动 peak picking：  选取工具栏 图标，并在 Peak 上面按

右键→Add Peak to list 
自动 peak picking：  选取 主菜单→Peak Picking 会出现如下窗

口： 

 
1.从 “Region”设置想要  Peak Picking 的范围；可由 ”Set to”选择 “Full 
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第六章 2D 图谱处理 

Range /displayed Range” 
2.再将“Minimum Intensity [rel] (MI)”以“Set to”选择“Lowest contour level” 

(需先将图谱强度调到合适值) 
3.依目测预估值，来评估是否需要更动 Peak 最大数量(Maximum # of 

peaks)的值 
4.按 OK 即进行 auto peak picking 

6.5 2D Peak integration 

当 2D 图谱完成 Peak picking 后，即可进行 Peak integration。 点选主菜

单→Analysis → Integration 出现以下窗口： 

 
选取“relative threshold / absolute threshold”皆可，从积分列表会显示两个

信息。 
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第七章 打印/输出 

当按下 按钮时，会出现以下窗口： 

 
Options 选项， 
→ Print active window [prnt] 
将目前窗口所显示的图谱格式直接打印出来 
→ Print with layout – start Plot Editor [plot] 
进入”Plot Editor”窗口，此时会套用”LAYOUT”的格式，再进一步编辑。(关

于编 辑部份，请参阅 XWinPlot 说明) 
→ Print with layout – plot directly [autoplot] 
套用”LAYOUT”格式，直接输出成数据。 
LAYOUT：此栏位的选项，都是图谱打印模板文件，用以套用打印格式。

除了 预设的模板文件，亦可自行在 Plot Editor 中保存自己设置的模板文件。 

◎如何打印积分列表？ 

在图谱窗口中，将页面切换到积分列表，如图： 
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6.5 2D Peak integration 

 
再于命令行中输入”print”即可打印。 

◎如何打印 Peak List？ 

将图谱窗口切换到 Peaks 页面，如图： 

 
再于命令行中输入”print”即可打印。 
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第八章 图谱分析 

8.1 测量两点之间的距离/ Distance Measurement 

按下工具栏 图标，使其呈现绿色，即进入测量模式。按鼠标左键定义

起点并拖动至终点处，即会显示两点之间的距离。按下鼠标右键则离开测量模

式。 

8.2 计算信噪比/ Signal to Noise Calculation 

按下菜单→ Analysis → Signal/Noise Calculation。先拖动一段范围做为信

号范 围，再拖动一段范围做为背景噪声范围。信号范围需涵盖想计算的信号，

背景 噪声范围则挑平坦没有信号的背景区间即可。举例如下： 

 
选好区间后，按鼠标右键会出现菜单，如下图 

 
选“Start S/N Calculation”开始进行信噪比计算。 
选“Clear NOISEREG / Clear SIGREG”取消所选取的范围信号/噪声范围 
选“Edit Regions”手动输入信号/噪声范围 
选“Change Region Widths”改变所选取范围的宽度 
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8.3 T1,T2 弛豫分析/Relaxation Analysis 

选“Quit”离开“Signal/ Noise Calculation”模式 

8.3 T1,T2 弛豫分析/Relaxation Analysis 

当完成一个 T1/T2 实验，点击主菜单→Analysis→T1/T2Relaxation 进入 
T1/T2 计算功能。如下图： 

 
1.按 Extract Slice → FID 取出第一个 FID 
2.按 DefineRanges 进入积分模式，将需要计算的 peak 进行积分(可选择

多根 peak)。选择完毕后按 →Export regions to Relaxation Module。 
3.按 Relaxation Window 
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第八章 图谱分析 

 
此时从 Fitting type 可以选择用 Intensity 或 Area 做为计算标准。 
4. Current Peak 显示目前表示的是全部 Peak 的第几个 
5. Brief Report 即显示这个 peak 的计算结果及一些参数 
功能键： 

  计算目前这一个 Peak 

  计算全部的 Peak 

  至前一个 Peak 

  至下一个 Peak 

  计算公式的微调选项 

  时间轴以线性函数表示法 

  时间轴以对数函数表示法 

  时间轴以次方函数表示法 

  离开 

  显示详细报告 

8.4 重叠峰拆解/ Deconvolution 

使用目的：将波峰重叠严重的地方，用 Gaussian/Lorentzian 曲线去求出

每个 Peak 所占的比重，如图：原本重叠的图谱： 
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8.4 重叠峰拆解/ Deconvolution 

 
重叠峰拆解结果图： 

 
将显示范围移到需要执行重叠峰拆解的地方，按下主菜单→ Analysis→ 
Deconvolution 会出现以下画面： 
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第八章 图谱分析 

 
Options (选项) 
→ Use Lorentzian shape 
使用 100% Lorentzian 函数 
→ Use Gaussian shape 
使用 100% Gaussian 函数 
→ Use mixed shape, auto peak pick into file ‘peaklist’ 
使用混合函数，将自动判定出的 peak 值存入 peaklist 
→ Use mixed shape, use peaks from file ‘peaklist’ 
使用混合函数，并以 peaklist 所记载的 peak 做为依据 
→ Generate file ‘peaklist’, no deconvolution 
只将自动判定出的 peak 存入 peaklist，不执行重叠峰拆解 
→ Display result of the last deconvolution 
显示最后一次做的结果 
→ Display the Lorentz / Gauss curves of the last deconvolution 
显示重叠峰拆解之后，每个 peak 的组成 
Required parameters (需填入的参数) 
→ Left deconvolution limit F1P[ppm] 
设置左界(预设为窗口所见左侧) 
→ Right deconvolution limit F1P[ppm] 
设置右界(预设为窗口所见右侧) 
→ Minimum intensity MI (rel) 
自动判定 peak 的最低高度 
→ Maximum intensity MAXI (rel) 
自动判定 peak 的最高高度 
→ Destination PROCNO for fitted data 
将重叠峰拆解结果存入一个 PROC NO. 
备注： 
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8.5 J-耦合分裂分析/ Multiplet Analysis 

2D 的图谱亦可进行 Deconvolution，但须先自行 peak picking 

8.5 J-耦合分裂分析/ Multiplet Analysis 

点选主菜单→Analysis → Multiplet Analysis，如下图： 

 
将 Peak 定义为同一组 J-耦合分裂的方式有三个 

1   以鼠标框选范围，范围内的 Peak 会被定义成同一组 J 
耦合分裂(范围内必须先 peak picking) 

2   手动定义  J 耦合分裂，先以左键点出每个  Peak 的位

置，再按右键出现选单→Define Multiplet 

3   以等距网格线一次定义 J 耦合分裂内所有 Peak，先按右

键出现选单，选择 Peak 数量，再将光标移至 Peak 群中最中间者，按左键即

会出现与 Peak 相等数量的等距网格线。将每个网格线的位置调至每个 Peak 
的峰顶， 再按一次左键即完成定义。 

  将已存在的 J 耦合分裂再合并成一个 J 耦合分裂丛集，

将想要合并的 J 耦合分裂以左键选取，再按右键选 Define Multiplet 

  以等距网格线合并已存在的 J 耦合分裂成一个 J 耦合分

裂丛集。先选取 其中一个 Multiplet 再点选此按钮，则会出现与此 Multiplet 
相同分裂数 的网格线，将其放置于另一个 multiplet 对齐再按左键即可。按右

键可选择分裂数。 

  将 J 耦合分裂中定义的位置(即指在 Peak 上方的网格线)
做左右移动的 动作 

  选择前一个 J 耦合分裂定义 

  选择下一个 J 耦合分裂定义 

  选择 J 耦合分裂丛集的上一个层次 
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第八章 图谱分析 

  选择 J 耦合分裂丛集的下一个层次 

  调整 J 耦合分裂网格线的水平高度 

  删除所选择的 J 耦合分裂 

  取消最后一次的动作 

  重做最后一次的动作 

  调整 Multiplet 参数值 

  查看 Report 
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